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WARNING

Read this entire manual and all other publications pertaining to the work to be
performed before installing, operating, or servicing this equipment. Practice all
plant and safety instructions and precautions. Failure to follow instructions can
cause personal injury and/or property damage.

The engine, turbine, or other type of prime mover should be equipped with an
overspeed shutdown device to protect against runaway or damage to the prime
mover with possible personal injury, loss of life, or property damage.

The overspeed shutdown device must be totally independent of the prime mover
control system. An overtemperature or overpressure shutdown device may also be
needed for safety, as appropriate.

é CAUTION
To prevent damage to a control system that uses an alternator or battery-charging
device, make sure the charging device is turned off before disconnecting the battery
from the system.

In systems where large inductive loads are switched on the DC power buss, surge
impulse energy will be present due to the switching. To address surge energy
affects on the control, appropriate suppression devices must be installed in the DC
power buss prior to the control’s power connection.

Electronic controls contain static-sensitive parts. Observe the following precautions

to prevent damage to these parts.

e Discharge body static before handling the control (with power to the control
turned off, contact a grounded surface and maintain contact while handling the
control).

e Avoid all plastic, vinyl, and Styrofoam (except antistatic versions) around
printed circuit boards.

¢ Do not touch the components or conductors on a printed circuit board with
your hands or with conductive devices.

IMPORTANT DEFINITIONS
WARNING—indicates a potentially hazardous situation which, if not avoided, could
result in death or serious injury.

result in damage to equipment.

NOTE—provides other helpful information that does not fall under the warning or
caution categories.

A CAUTION—indicates a potentially hazardous situation which, if not avoided, could

| Revisions—Text changes are indicated by a black line alongside the text.

Woodward Governor Company reserves the right to update any portion of this publication at any time. Information
provided by Woodward Governor Company is believed to be correct and reliable. However, no responsibility is
assumed by Woodward Governor Company unless otherwise expressly undertaken.

© Woodward 2005

All Rights Reserved
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Regulatory Compliance

European Compliance for CE Marking

EMC Directive

Declared to 89/336/EEC COUNCIL DIRECTIVE of 03 May 1989 on the
approximation of the laws of the Member States relating to electromagnetic
compatibility.

Electromagnetic Compatibility
Testing was performed to ISO/EN 14982:1998 and EN 13309:2000 standards.

Evaluations, other than specific testing, were performed to cover:
e EN 12895:2000

e EN61000-6-2:2001
e EN 61000-6-4:2001

Testing to EN 14982:1998 and application specific installation requirements
cover evaluations. (See Chapter 1 of this manual for intended usage of this
unit.)

EMC Limitations

All cabling for these controllers is limited to less than 3m (9.84’).
Power cabling is limited to less than 10m (32.8’) in total length.
See wiring diagrams for specific cable types required.

Declaration of Conformity
The official Declaration of Conformity is printed on page 58 of this manual.

Woodward iii
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Electrostatic Discharge Awareness

All electronic equipment is static-sensitive, some components more than others.
To protect these components from static damage, you must take special
precautions to minimize or eliminate electrostatic discharges.

Follow these precautions when working with or near the control.

1. Before doing maintenance on the electronic control, discharge the static
electricity on your body to ground by touching and holding a grounded metal
object (pipes, cabinets, equipment, etc.).

2. Avoid the build-up of static electricity on your body by not wearing clothing
made of synthetic materials. Wear cotton or cotton-blend materials as much
as possible because these do not store static electric charges as much as
synthetics.

3. Keep plastic, vinyl, and Styrofoam materials (such as plastic or Styrofoam
cups, cup holders, cigarette packages, cellophane wrappers, vinyl books or
folders, plastic bottles, and plastic ash trays) away from the control, the
modules, and the work area as much as possible.

4. Do not remove the printed circuit board (PCB) from the control cabinet
unless absolutely necessary. If you must remove the PCB from the control
cabinet, follow these precautions:

¢ Do not touch any part of the PCB except the edges.

. Do not touch the electrical conductors, the connectors, or the
components with conductive devices or with your hands.

e  When replacing a PCB, keep the new PCB in the plastic antistatic
protective bag it comes in until you are ready to install it. Immediately
after removing the old PCB from the control cabinet, place it in the
antistatic protective bag.

é CAUTION
To prevent damage to electronic components caused by improper
handling, read and observe the precautions in Woodward manual
82715, Guide for Handling and Protection of Electronic Controls,
Printed Circuit Boards, and Modules.

iv Woodward
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Chapter 1.
General Information

Introduction

DSS-2 (Digital Speed Switch, 2-Channel) is a two-

DSS-2 monitors engine rpm via a magnetic pickup
(MPU) input and controls two independent relays.
Once engine speed exceeds the user selected speed
setpoint, the relay will go to the designated set
condition. DSS-2 can also be re-configured with the
ACT (All-purpose Calibration Tool) to function as an
engine autocrank controller or glow plug controller.

channel electronic speed switch that combines the &
convenience of manual adjustments with the flexibility T
of a computer-based calibration tool. DSS-2 was i
designed for use on engine applications where it can @EI:F@
perform a variety of speed related functions such as @ & i_g
starter motor disable and engine overspeed protection. ®l|:|jg
9
o
il
ilis

B

DSS-2 has two multi-turn potentiometers for manual speed setpoint adjustment. A
computer interface is provided for additional adjustments with the All-purpose
Callibration Tool (ACT). Electrical connections consist of thirteen wires and utilize a
Euro-style terminal strip. For most applications, DSS-2 can be connected and
adjusted with simple hand tools. For more advanced features, the calibration tool
provides user-friendly access. Three indicator lamps permit system monitoring and
diagnosis without use of additional tools.

As shipped from the factory, DSS-2 can be manually adjusted on most applications
that supply a MPU frequency of 2500 to 5000 Hz. Optionally, the user may attach
the calibration tool (ACT) to gain access to a number of user-adjustable features
including:

¢ Frequency range (10-10,000 Hz)

e Normal and reverse mode operation

e Automatic, Manual or Latched reset

e Set condition on Engine Protection (EP) switch on
e Set condition on loss of speed signal

e Set condition on Start Switch (VER) off

e Autocrank: Configure crank disconnect speed range, crank time, rest time
and number of crank attempts

e  Glow plug preheat

Intended Usage

The DSS-2 is intended as a sub-system for integration into construction/
commercial and industrial engine systems by original equipment manufacturers
and industrial plants. It is not intended for consumer or on-highway vehicles or
for use by the general consumer/public. Typical applications include generator sets,
compressors, construction machinery, and farm vehicles.

Woodward 1
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Slow Blow Fuse

I—\/\T
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Start Switch

i i
Slow Blow Fuse | Slow Blow Fuse

(10 amp)
(10amp) Mag. Pickup

Ignition Kill
Relay

Twisted Pair Shielded Wire
(shield grounded at controller only)

DSS2 Controller

Figure 1. DSS-2 Engine Control System

How Speed Switches Work

The purpose of a speed switch is to monitor the speed of a rotating device, such as
an internal combustion engine, and close or open a set of switch contacts when
speed exceeds a threshold. Speed switches are most often used to disengage
starter motors when the engine starts, and to shut down the engine should an
overspeed occur. With the addition of some logic, speed switches may be applied to
a number of applications. Electrical loads controlled with a speed switch include
starter relays, ignition system power, indicator lamps, glow plug relays, solenoids
and electro-hydraulic valves.

Set vs. Reset

Speed switches make frequent use of the terms “Set” and “Reset.” The “Reset”
condition or state is that which exists when the unit is first powered up and when
engine speed is below the speed threshold. Once speed rises above the threshold
(set speed), the speed switch output (relay) transitions to the “Set” condition. In
some cases, depending on configuration, the speed switch can return to the “Reset”
condition when engine speed drops below a lower threshold (reset point), or when a
manual reset switch is actuated. The speed switch may also be configured to latch a
Set condition until battery power is cycled.

Normal vs. Reverse Relay Logic

A normally configured speed switch channel has the relay de-energized in the Reset
condition and energized in the Set condition. It is possible to configure each channel
in Reverse mode such that the relay is energized in the Reset condition and de-
energized in the Set condition. This is helpful in applications such as engine crank
disable where a loss of power to the DSS-2 should produce the same response as

2 Woodward
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exceeding the set engine speed. Configuring a channel in normal mode for a crank
disable feature could cause overcranking if power were interrupted to the DSS-2.

Autocrank

The DSS-2 speed switch channels can be easily configured to provide an autocrank
feature using the ACT. In this mode, applying battery voltage to the VER input will
initiate the starting sequence. When this happens, the relay will be energized until
either the engine starts, or a maximum crank time is exceeded. If the latter occurs,
the logic will wait for a rest period before attempting to crank again. Crank time, rest
time and maximum number of crank attempts are user selectable using the ACT.
The rpm at which the DSS-2 assumes the engine has started, referred to as the
crank disable speed, is adjustable using the multi-turn potentiometer for that
channel.

Glow Plug Preheat

When one channel of the DSS-2 has been configured for autocrank, the user may
configure the other channel as a glow plug controller. In this mode, the DSS-2 will
energize the glow plug relay for a fixed period of time before engine cranking begins.
The relay will remain on until the end of the crank period, or until the engine starts —
whichever comes first. The glow plug relay will remain on during the rest period
provided that the glow plug preheat time is longer than the rest time, if not, the glow
plug relay will be turned off until the appropriate preheat delay prior to the next crank
attempt. The maximum glow plug preheat time is user selectable using the ACT.
The actual preheat time is adjustable between zero and the maximum using the
multi-turn potentiometer for that channel.

System Components

The two components required to install a DSS-2 on an engine are the DSS-2 controller
and magnetic pickup (MPU) speed sensor. Since both components contribute to the
overall performance of the system, shortcomings in either will detract from total system
performance. Optionally, the All-purpose Calibration Tool (ACT) may be used to
customize operation.

DSS-2 Controller

DSS-2 contains a powerful microcontroller that processes
the signal received from the MPU sensor and compares it
to the speed setpoints. Output control is accomplished by
means of two independently controlled form-C relays with
Common (C), Normally Closed (NC) and Normally Open
(NO) contacts.

The DSS-2 controller has two multi-turn potentiometers
for speed setpoint adjustment. A computer serial
interface is provided for additional adjustments with the ACT.

The controller has thirteen Euro-style screw terminals for:

e Battery Positive and Negative (9-30 Vdc). Reverse voltage protected.

e Two form-C relays (10A continuous). Independent Common (C), Normally
Closed (NC) and Normally Open (NO) contacts are provided. DSS-2 is
factory programmed for standard relay logic (relay de-energized below set
speed), but may be modified with the ACT for reverse relay logic (relay
energized below set speed). External diodes should be added for transient
suppression with inductive loads.

Woodward 3
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e Magnetic Pickup (MPU) Positive and Negative (2 Vac minimum at 1000 Hz).
The controller is factory programmed for 2500 to 5000 Hz. This range may
be modified with the ACT to cover 10 t010,000 Hz or operate in units of rpm.

e Reset Switch Input (RST): A switch to battery positive switch input is
provided for manual reset functions. DSS-2 is factory programmed for
automatic reset at 80% of set speed, but may be modified with the ACT for
manual or latched reset.

e Engine Protection Switch Input (EP): A switch to battery positive switch
input is provided for connection to external engine protection devices.

e Verify Switch Input (VER): A switch to battery positive switch input is
provided for a verify function. Activating this switch will reduce both
channel set frequencies to 70% of their normal values. The VER input
also functions as a Start/Stop switch input in certain modes of operation.
When a channel is configured as an autocrank controller, the Verify switch
is used to initiate the start sequence. If a channel uses the Verify switch
as a Start Switch, removing the switch input will force the channel to a set
status.

Use insulated, automotive grade wiring (minimum 18 AWG or 1 mm?) for all connections.
Shielded wiring is recommended for the MPU.

The DSS-2 is equipped with three LEDs: one green and two red. All LEDs will be turned on
for one second following power up as a lamp test and as an indication of normal operation.

Green LED:

The green LED is an engine status indicator and functions as follows:
OFF: No engine speed
ON: Engine speed sensed
Flashing: Fault present

Red LEDs:
The red LEDs are each assigned to a speed switch channel.

e When a channel is configured as a speed switch, its LED will be illuminated
when the channel relay is in the Set condition.

e When a channel is configured as a glow plug controller, its LED will be
illuminated when the relay is energized (glow plug ON).

e When a channel is configured as an autocrank controller, its LED will be
illuminated when the relay is energized. The LED will flash rapidly during the
starter rest period (relay de-energized).

4 Woodward
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Speed Sensor

DSS-2 monitors engine speed continuously using
a magnetic pickup (MPU), which detects the
passing of teeth on an engine driven gear (e.g.,
flywheel). The frequency of the voltage generated
by the MPU is proportional to engine rpm.

>

A variety of MPU sensors are available from
Woodward.

All-purpose Calibration Tool (ACT)

ACT is a PC (personal computer) based software calibration and
monitoring tool. ACT is designed specifically for use with engines
equipped with the DSS-2 controller. The tool can be run on any
IBM compatible computer that meets the requirements listed in
“ACT Installation” in Chapter 5.

Once the DSS-2 controller has been programmed, ACT may be
disconnected. The DSS-2 unit will continue to operate normally
with ACT either connected or disconnected.

Woodward P/N SA-5206

CAUTION
A An unsafe condition could occur with improper use of these software
tools. Only trained personnel should have access to these tools.

Woodward 5
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Chapter 2.

Specifications
|

Woodward P/N: 8800-1001

Electrical

Power Input

9-30 Vdc, reverse polarity protected

Electromagnetc Compatibility

See Regulatory Compliance on page iii.

Operating Current:
Both Channels On:

Both Channels Off:

12V:100 mA /24 V: 100 mA
12 V:50 mA /24 V: 50 mA

Relay Contact Ratings @ 28 Vdc

Resistive Load: 1 to 10A
Inductive Load: 1 to 8A

Mechanical

Operating Temperature

-40°F to +185F (-40°C to 85°C)

Vibration

4 G’s from 40 to 2000 Hz

Shock

10 G’'s @ 45 Hz

Housing

UV, chemical resistant. UL 94 V-O
flame retardant. Encapsulated for
reliability in harsh environments

Terminations

Euro-style terminal block

Calibration

Manual or with PC-based All-purpose
Calibration Tool / ACT [SA-5206]

Weight:

0.38 Ibs (0.17 kg)

NOTE

www.woodward.com.

The scope of this manual does not include selection of speed
sensors or other components that Woodward offers for use with
the DSS-2 system. Information is available on our website at

NOTE

your application.

The need for sub-components such as switches is application
dependent. Please contact Woodward for information specific to

Woodward
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Chapter 3.

Installation
]

CAUTION
A Take adequate protection to ensure personal and equipment safety
and follow the suggested installation sequence given below.

Refer to Figures 2 & 3 and Table 1 to install the system and subcomponents.

DSS-2 Mounting

Mount the unit in a location where the effects of vibration and temperature are within
the specified range. Operating temperature: -40°F to +185°F (-40°C to +85°C);
vibration: 6 G’s from 40 to 2000 Hz. (See Figure 2 for controller dimensions.)

DSS-2 Wiring
DSS-2 has thirteen Euro-style terminals for external connections. To use:

1. Loosen the terminals with a small blade screwdriver.
2. Strip wire.

3. Insert wire into terminal hole.

4. Tighten terminal with a small blade screwdriver.

Refer to Figure 3. Use proper wire gauges (18 AWG/ 1 mm? minimum). All wire
insulation should be appropriate for engine applications. Terminations must be
impervious to moisture to prevent shorts and corrosion.

Use of convoluted tubing, conduit, or other wire shielding is recommended to
minimize the likelihood of mechanical damage to wires. Avoid routing wires near
sharp edges or near locations that can cause the wires to be pinched or damaged.

Power Leads: Power leads are to be connected directly to a switched power
source (i.e., battery). With both channels on, DSS-2 draws a maximum of 100 mA.
Use of a slow-blow fuse is recommended in the battery (positive) wire. Electrical
loads attached to the two relays should be separately fused.

MPU Wiring: Use shielded cable for MPU signal. The shield should be connected
to the battery ground wire at one end only.

Output Loads: Channel 1 and Channel 2 output relays may be connected to a
variety of electrical loads including starter relays, engine ignition systems, fuel
shutdown solenoids, indicator lamps, hydraulic solenoid valves, etc. The current
requirements of the load must be matched to the contact capability of the output
relays (10A resistive load). When the output relays are connected to inductive loads
(e.g. solenoids) external diodes should be added to increase contact life and for
transient suppression. Electrical loads attached to the two relays should be
separately fused.

Excessive resistance in the wiring will result in reduced current to the electrical load.
Such increased resistance can result from too much wire length, inadequate wire
gauge, or poor connections. Total wiring length—between battery power and the
DSS-2 as well as between the DSS-2 and the load—must be considered.

Woodward 7
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It is important to use good quality terminations and proper crimping technique.

Switch Inputs: The switch inputs (VER, RST, EP) draw very little current (less than
1 mA each). The external switches should be selected for prolonged use at these
low currents. One side of the switch should be connected to battery voltage and the
other side connected to the DSS-2 switch input.

((') (&) T+
all o o]0 oW W 1y
N|VIN O N[N ON|d[d[d[s|3
ols8 ZHD THD ¥ [¥ |3 |y]|A
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e882.20.2002.0/0.8
@175(4.4mm)
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\\ - ‘\\ - < (q\] e cg>
z | ¢ ) RS
3 8 g
0 @

3 Q g

ad

\( L1 \’ﬁ i, y

—— 350(88.9mm)}——— P

1.39(35.3mm)
.88(22.3mm)

Figure 2. DSS-2 Dimensions
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Table 1. Controller Wiring

FUNCTION PIN INFORMATION
Battery BAT (+), GND (-)
MPU Speed Signal Input RPM (+), RPM (-)
Channel 1 C-1, NC-1, NO-1
Channel 2 C-2, NC-2, NO-2
Verify/Start Switch VER
Reset Switch RST

Engine Protection Switch EP
ACT Connector RCV (Pin 4), TXD (Pin 3), GND2 (Pin 1)

CAUTION
A To prevent damage to the controller, make sure that it is wired in
accordance with the wiring instructions and diagrams in this manual.

¢ Do not tin the leads before placing them into the terminals.
e Ensure the terminals are tightened properly to secure wires.

Woodward 9
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Controller Pinout

Use the diagram below to connect your DSS-2 controller to battery power, the mag pickup, loads,
switches, and ACT.

NOTE

®

All cabling for these controllers is limited to less than 3m (9.84’). Power
cabling is limited to less than 10m (32.8’) in total length. The wiring
diagram below shows specific cable types required.

Slow Blow Fuses

Calibration Tool S | Power (DC)
alibration Tool Setup 1 amp _“_—u:_*,
- 10 amp o '—,_-
10 amp 2 Y |
Campitar
- g e Solenoid or other device
(10 A Max)
Grd (P &
(]
| TAD PN 2) M—mﬂiﬁ
RCV (P3) 7 £
4 Solencid or other device
% (10 A Max)
%}g-:gﬂ]; ,;H[ ‘§
Rcl.ll;p:‘:: Channel 2 -
Adjust
Vo T—L
(GNDL-]
ELAT(+}
[T "
[
e
(=3 Twisted Pair Shielded Wire Magnetic Fickup
ﬁ_ i) {shield grounded at controller anly ",
=
o - —
VER 'Tr—||l
s o Engine Protect
L 2L
DES-2 Controller
- Channel 1
Adjust Manual Reset
L
Verify Swiich
IH

Figure 3. DSS-2 Wiring Diagram

10
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Speed Sensor Installation

Installed opposite an engine driven gear such as the
flywheel, the mag pickup (MPU) transmits a signal \
each time the magnetic flux path across the pole is [
interrupted by a gear tooth. The frequency of the AC f Wlmel[ﬁ—b;
signal generated by the MPU is proportional to the ~J

engine speed.

The mounting of the sensor unit must be rigid; excessive vibration can cause
erroneous signals and unreliable performance.

MPU output voltage is affected by tooth speed and gap size between the sensor
and the gear tooth. The higher the tooth speed, the higher the output voltage.
Conversely, the larger the sensor gap, the lower the output voltage. In general,
gap of 0.015 to 0.018” (0.38 to 0.46mm) is adequate for most engines and
operating speeds. If the gap cannot be measured, it may be adequate to do the
following:

1. Align a gear tooth in the center of the hole.

2. Install the MPU until the tip touches the tooth. This assumes that the
hole is tapped to the full depth and no burrs exist which preclude
moving the sensor all the way up to the tooth.

Unscrew the MPU approximately one-quarter to one-half turn.
While holding MPU position fixed, tighten lock nut.

Hand turn the engine one complete revolution to confirm that none of
the gear teeth contact the MPU.

Connect the speed sensor to the two rpm inputs on the controller. Most sensors
do not have a positive or negative side and can be connected either way. Use
twisted pair shielded wire for all speed sensor wiring. The shield should be
grounded at the controller only. DSS-2 requires a minimum output voltage of

2 Vac. It is recommended that the MPU output not be shared with other devices
(tachometers, etc.).

FPMs

D&sS-2

B
E

RPM-

Figure 4. Speed Sensor Wiring

The frequency of the signal coming out of the MPU is related to the engine rpm as

follows:
Frequency (Hz) = RPM X nteeth/60
Where nteeth is the number of teeth on the gear adjacent to
The MPU (usually the flywheel).
Conversely:

RPM = frequency X 60/nteeth

Many hand held digital multi-meters can measure signal frequency (Hz).
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Chapter 4.

Calibration
]

Calibration Guide

This section explains the procedures for calibrating (configuring and adjusting) the
various DSS-2 features to work with your application.

Each of the two DSS-2 channels can be independently configured as:

e Speed Switch (either normal or reverse acting)
e Autocrank Controller
e Glow Plug Controller

Each of these will be addressed separately.

Before proceeding, make sure you have completed the installation of all the required
hardware for your system as discussed in Chapter 2.

Manual Calibration

DSS-2 is equipped with two operator-adjustable potentiometers, one for each
channel. These are multi-turn potentiometers that require 20-30 turns to cover the
full range of setspeeds. The potentiometers have an internal clutch to prevent
damage from overturning. The function of the potentiometer will vary depending on
how the DSS-2 is configured.

Calibration with ACT

ACT (All-purpose Calibration Tool) can be used to provide a wide variety of custom
features to the DSS-2. Refer to Chapter 5 for general information regarding installation,
connection and operation of ACT. The Calibration Wizard is the preferred approach to
ACT calibration, but similar results can be obtained using the Calibrate/Change DSS-2
Calibration Menu item (see Chapter 5 for details). ACT is not required as long as the
channels have been previously configured as desired by the user.

To launch the Calibration Wizard:

1. Select “Calibrate”, then
Calibration Wizard.

12 Woodward
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DSS-2 Calibration Wizard 3]

2. Select default Values Or \Ei\l/ijﬁuanleuluusgazZW\zavd,snmlevzcnveguldelugemngyumDEE—Zupandvunmngasqumklyand
current values as a starting
point in the calibration. When
adjusting a DSS-2 that, for
the most part, has the
desired calibration, it is best I Sttt et vakes oot s,

to use “current values”.

it values read fiom the

The Wwizard will be initialized with the default val
I Stat it defeul vaes i e, Al calbration velues il b race,

sl - 3. Enter the number of teeth on
the flywheel. If you wish to
work in Hz, enter a value of
60. If you wish to work in rpm,

enter the correct number of
flywheel teeth.

4. Information in the following
sections will detail how ACT
can be used to configure both
channels and the Engine
Protection (EP) input.

CAUTION

A The DSS-2 is a user configurable engine control device and will follow
your settings and commands immediately. Please be aware of this when
calibrating and entering values in the unit.

It is possible to enter values in the DSS-2 unit that are in excess of what
the engine is capable of performing and outside of safe operating range.

It is the user’s responsibility to be accurate when entering data into the
DSS-2 or the ACT. Entering values outside of safe operating range can
result in serious physical injury and/or damage to the equipment or
application.
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Speed Switch Configuration

As shipped from the factory, DSS-2 is configured as follows:

Two-channel speed switch

Normal operation

Automatic reset at 80% of setspeed

Range of pot adjustable set speed: 2500 to 5000 Hz
Go to set condition on EP switch input

Set speed reduced to 70% on VER switch input

The speed setpoints can be calibrated manually by adjusting the two potentiometers
on the front of the DSS-2 controller.

A typical speed switch installation is shown below.

In this example, Channel 1 is configured as a crank disable switch that disconnects
power to the starter motor when engine speed rises above the set speed. Channel 2
is configured as an overspeed shutdown switch that will interrupt power to the
ignition coil when an overspeed threshold is exceeded.

[

Slow Blow Fuse

Battery

i l
Slow Blow Fuse | Slow Blow Fuse

{10 amp)
N0 ank) Mag. Pickup 4

i
a i

JE

= Crank Disable
Relay

~

i

L)

Ignition Kill
Relay

Twisted Pair Shielded Wire
(shield grounded at controller only)

DS52 Controller

Figure 5. Typical Speed Switch Installation
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Manual Calibration

Calibration is best done with a frequency generator to simulate the engine speed input
and a frequency meter. A zero-crossing input of 2 Vac minimum is required. Setup
consists of the following:

1. Set potentiometers to maximum frequency (fully clockwise — potentiometer will
click at end of travel).

2. Apply power to controller. All three LEDs should turn on for one second,
indicating normal operation.

3. Turn on frequency generator and set to desired frequency. The green status
LED should turn on continuously, indicating a good speed signal from the
generator.

4. Adjust speed setpoints until desired set speeds are achieved. Red LEDs
should illuminate when set speeds are reached.

5. Install DSS-2 on engine and confirm MPU input with engine running. Confirm
speed switch operation. If concerned about overspeeding the engine or load,
attach 12 volts to the verify (VER) input. Speed switching will occur at 70% of
the actual set speed.

The range of set speeds commanded is adjustable using the ACT. Due to the
resolution of the internal digital electronics, it may not be possible to adjust operation
to the exact frequency (e.g. 60.1 Hz vs 60 Hz). The wider the range, the coarser the
resolution.

Speed Switch Calibration Using ACT

The All-purpose Calibration Tool (ACT) can be used to provide a wide variety of
custom features to the DSS-2. Refer to Chapter 5 for general information regarding
installation, connection and operation of ACT. The Calibration Wizard is the
preferred approach to ACT calibration, but similar results can be obtained using the
Calibrate/Change DSS-2 Calibration Menu item.

To launch the Calibration Wizard:

1. Select “Calibrate”, then Calibration Wizard.
2. Select default values or current values as a starting point in the calibration.

3. Enter the number of teeth on the flywheel. If you wish to work in Hz, enter a
value of 60. If you wish to work in rpm, enter the correct number of flywheel
teeth.

4. The following information applies to both Channel 1 and Channel 2.

Woodward 15
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Normal Operation vs. Reverse Operation

In the first Wizard window, left click on the down arrow in the selection box and
select normal or reverse operation. Click on Next to move on to the next selection.

DSS-2 Calibration Wizard 3

Channel Configuration Channel 1

Channel Configuration: X

p
ALtocrank Controller
Glow Plug Controller

< Back Mexut » Cancel

Reset Mode: Auto/Manual/Latch
Click on the down arrow in the selection box and select the desired reset mode.

Auto Reset: The speed switch will automatically return to the “Reset” state when
speed falls below a percentage of the setspeed. The percentage is selected in the
next window.

Manual Reset: The speed switch will return to the “Reset” state when the speed
falls below the setspeed AND the RST switch input is connected to battery voltage

Latched Reset: The speed switch will remain in the "Set” state until the DSS-2
module is powered down then powered back up.

DSS-2 Calibration Wizard X

Chatnel Configuration Channel: 1
Channel Configuration: Reset Option: | TeRe Tl aler | Speec -

Automatic Reset on % of Set Speed
Rieset with Manual Reset switch
Latched reset

< Back I Hext> Cancel
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Speed Switch Options

Potentiometer Control
Range:
Channel Cortiguiation Chamnet | 1 Set Speed Min and Set
Chrnel Cofiguatons [T 5005 100 <] esstOpton | ] Speed Max specify the
Set peed Min (pml: [25000 range of engine Speeds
e E. (frequencies) controllable

Set Delay [msec) [1000msec = 1sec |0 .
. with the set speed

Engine Pratection L

iy Swich - potentiometer. Values of
Lossof peed =5t 7 10-8000 are acceptable.
Somea r The narrower the range,
Hakidit B L the finer the resolution on
Reset Dislay [meec] (1000msec = 1sac) |0 .

Reset Percentage (%) 073333 adj UStm e nt'

Delay on Set Condition:
Set Delay specifies how
long, in msec, that actual
ced || speed must exceed the
set speed before going to
the set condition. This permits the system to ignore small glitches in measured
engine speed.

< Back

Go to Set Condition on Engine Protection Switch: If the Engine Protection box is
checked, the speed switch will go to the set condition any time the Engine Protection
Switch input is set to a high voltage, regardless of the speed.

Go to Set Condition when Start/Verify Switch is off: To use the VER input as a
“Start/Stop” switch, check the Verify Switch box. Any time the VER input is low, the
speed switch will go to the set condition, regardless of the speed. As long as the
speed is below the set speed, the speed switch will return to the reset condition
when the VER input is connected to high voltage. This feature is useful when using
the speed switch for overspeed shutdown as well as start/stop. When this feature is
enabled on either channel, the normal verify function will be disabled.

Go to Set Condition on Loss of Speed: If the Loss of Speed = Set box is
checked, the speed switch will go to the set condition upon loss of the speed signal.
This can be used to assure an engine shutdown in the event that the MPU signal is
lost.

Sequence with other channel: If the Sequence box is checked, the speed switch
will not go to a set condition based on speed until after the other channel has gone
to a set condition.

To generate a fault code when a set condition seen: When auto reset is used,
there is not an indication to the operator that a speed switch has gone to the set
condition and then returned to the reset condition. Checking the Overspeed Fault
Enable box will generate a fault code if the speed switch ever goes to the set
condition. The green status lamp will flash a fault code indicating the overspeed
fault.

Delay on Reset Condition: When the speed switch is configured for automatic
reset, Reset Delay specifies how long, in msec, that actual speed must fall below
the reset speed before going to the reset condition. This permits the system to
ignore small glitches in measured engine speed. Reset Speed = Set Speed * Reset
Percentage. This option is not displayed if manual reset or latched reset is selected.

To Adjust Reset Speed: When the speed switch is configured for automatic reset,
the user can select the speed below which the speed switch will return from the set
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condition to the reset condition. The reset speed is expressed as a percentage of
the set speed so that adjustments to the set speed with the set speed potentiometer
will also affect the reset speed. Reset Speed = Set Speed * Reset Percentage

Autocrank Configuration

As shipped from the factory, both DSS-2 channels are configured as speed
switches. The ACT is required to enable Autocrank operation. Once enabled, the
Crank Disconnect rpm can be manually adjusted using the potentiometer. Other
features which can be adjusted using the ACT include:

e Maximum engine cranking time
e Engine rest time between crank attempts
e Maximum number of crank attempts before giving up.

¢ Range of pot adjustable crank disconnect speed: default value
2500 to 5000 Hz

e Disable autocrank on EP switch input

If either channel is configured for autocrank, the normal Verify function is disabled.
The autocrank sequence is as follows:

1. The autocrank sequence is initiated by applying battery power to the VER
switch input. If power is removed from the VER switch input at any time, the
autocrank process will be terminated.

2. If one of the channels is configured as a glow plug controller, it will turn on
for the pre-heat time. The autocrank channel will remain off through the
duration of the glow plug pre-heat cycle.

3. The autocrank channel and the red LED will turn on to initiate cranking. If an
engine speed signal is not seen within AUTOCRANK_NS_TIME, a fault will
be generated and the autocrank sequence terminated.

4. The autocrank channel will remain on for AUTOCRANK_ CRANK_TIME
seconds or until engine speed rises above the crank disconnect speed,
whichever comes first.

5. If engine speed rises above the crank disconnect speed, the autocrank
process is complete.

6. If the autocrank channel remains on for AUTOCRANK_ CRANK_TIME
seconds, the channel will turn off and enter the rest phase for
AUTOCRANK_REST_TIME seconds, during which time the red channel
LED will flash rapidly.

7. After AUTOCRANK_REST_TIME seconds, the crank process will be
repeated until either the engine starts or AUTOCRANK_MAX_TRIES cycles
have been performed.

8. If the cycle has been repeated AUTOCRANK_MAX_TRIES times, the
autocrank process will be terminated and a fault generated.
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A typical autocrank installation is shown below.

In this installation, Channel 1 is configured as an overspeed shutdown switch that will
interrupt power to the ignition coil when an overspeed threshold is exceeded. Channel
2 is configured as an autocrank controller that will energize the starter motor when the
Start Switch is turned on. Additionally, an oil pressure switch and water temperature
switch are connected in parallel to the engine protection (EP) input.

Slow Blaw Fuse

[
/7

=N

Showt Blow Fuge Slorw Blow' Fuse
(10 amg) (10 amp)y

[ B

[Tl — o

5| 4 |

i
N Rl B
Crank Relay = gnitien Kl

Retay

Twested Far Shielded Wine
{shield grounded at controfler only)

DESE Conlroller

Water Temp.

I, S g

Swilsh Switch Switch

1

Figure 6. Typical Autocrank Installation

Manual Calibration

Calibration is best done with a frequency generator to simulate the engine speed
input and a frequency meter. A zero-crossing input of 2 Vac minimum is required.
Setup consists of the following:

1. Set autocrank potentiometer to maximum frequency (fully clockwise —
potentiometer will click at end of travel).

2. Apply power to controller. All three LEDs should turn on for one second,
indicating normal operation.

3. Turn on frequency generator and set to desired crank disconnect frequency.
The green status LED should turn on continuously, indicating a good speed
signal from the generator.
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4. Apply power to the VER switch input to initiate the starting sequence. If one
channel is configured as a Glow Plug controller, it will turn on first for the pre-
heat duration.

5. When the red LED for the autocrank channel turns on, begin turning the
potentiometer counterclockwise until the LED turns off. If the crank timer times
out before reaching the crank disconnect speed, the LED will begin flashing
rapidly indicating the rest period between crank attempts. Resume adjustment
when the next crank cycle begins, or cycle power to the VER switch to re-
initiate the crank sequence.

6. Install DSS-2 on engine and confirm MPU input with engine running. Confirm
autocrank operation.

The range of set speeds commanded is adjustable using the ACT. Due to the
resolution of the internal digital electronics, it may not be possible to adjust operation
to the exact frequency (e.g. 60.1Hz vs 60 Hz). The wider the range, the coarser the
resolution.

Autocrank Calibration Using ACT

ACT can be used to customize the Autocrank feature in DSS-2. Refer to Chapter 5
for general information regarding installation, connection and operation of ACT. The
Calibration Wizard is the preferred approach to ACT calibration, but similar results
can be obtained using the Calibrate/Change DSS-2 Calibration Menu item.

To launch the Calibration Wizard:

Select “Calibrate”, then Calibration Wizard.
2. Select default values or current values as a starting point in the calibration.

3. Enter the number of teeth on the flywheel. If you wish to work in Hz, enter a
value of 60. If you wish to work in rpm, enter the correct number of flywheel
teeth.

4. The following information applies to both Channel 1 and Channel 2.

Enabling Autocrank
DSS-2 Calibration Wizard x

Chanrel Configuration Channel 1

Channel Configuration: |[§

In the first Wizard

- = window, left click on the
e o Contiler down arrow in the
selection box and select
Autocrank Controller.
Click on Next to move
on to the next selection.

< Back I Mest > Cancel
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Autocrank Options

Engine Crank Time (sec):
This option permits DSS-2 Calibration Wizard 3]
adjustment of the maximum
crank duration. If crank
time exceeds this time, the

Chanel Configuration Channet: | 1
Channel Configuration: [Fooc o oncler <]

engine will enter a rest Engine Crank Time [sec) 0.0
periOd. Rest Tine [sec) 150
Mavimum number of crank attempts: |1

Marimum no-start time [sec) 1.0
a

able Speed fipm) {1000.0

Rest Time (sec):
This option specifies the Clnk Disale Speed (pm) [A000
rest’ or Coollng perlod’ Disable crark on Engine Protect H
between crank attempts.

Mini

Maximum number of
crank attempts: Specifies
the maximum number of
attempts to start the engine <Beck [l
after which the autocrank
sequence will be terminated.

"] cancel

Maximum Crank Disable Speed (rpm): Specifies the maximum crank disable rpm
selectable with the channel potentiometer.

Minimum Crank Disable Speed (rpm): Specifies the minimum crank disable rpm
selectable with the channel potentiometer.

To disable autocrank when an engine protection fault exists: Checking the box
labeled “Disable Crank on Engine Protect” will terminate the autocrank process if a
high voltage exists on the EP switch input.

Glow Plug Controller Configuration

As shipped from the factory, both DSS-2 channels are configured as speed
switches. Use of the ACT is required to enable glow plug controller operation. The
other channel must be configured for Autocrank operation. Once enabled, the Glow
Plug Preheat time can be manually adjusted using the potentiometer. The ACT can
be used to adjust maximum engine pre-heat time.

The glow plug sequence is as follows:

1. The autocrank/glow plug sequence is initiated by applying battery power to
the VER switch input. If power is removed from the VER switch input at any
time, the sequence will be terminated.

2. The channel configured as a glow plug controller will turn on for the pre-heat
time. The LED for the glow plug channel will be illuminated. The autocrank
channel will remain off through the duration of the glow plug pre-heat cycle.

3. Following the glow plug preheat, the autocrank channel and the red LED will
turn on to initiate cranking. The glow plugs will remain on during cranking
and will turn off once the engine starts.

4. During the autocrank rest period, the glow plugs will remain on if the pre-
heat time is greater than AUTOCRANK_REST_TIME. If the pre-heat time is
less, the glow plugs will be turned off until pre-heat time before the next
crank attempt.

5. If engine speed rises above the crank disconnect speed, the autocrank
process is complete and the glow plugs will be turned off.
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A typical glow plug installation is shown below.

In this installation, Channel 1 is configured as an autocrank controller that will energize the
starter motor when the Start Switch is turned on and after the glow plug pre-heat sequence
is complete. Channel 2 is configured as a glow plug controller that will energize the glow plug
relay as soon as the start switch is turned on. Additionally, an oil pressure switch is
connected to the engine protection (EP) input.

3

[ —
ml
H‘

Slow Blow Fuse

Glow Plug Relay
a
]
% % I
Slow Blow Fuse Slow Blow Fuse
(10 amp) {10 amp)

, E
J__Crsnlc Relay 4 -Jjj:_

Twisted Pair Shielded Wire
{shield grounded at controller only)

Engina Protect

DSS2 Controler %

Start Switch

o
a
.?.[[E

Figure 7. Typical Glow Plug Installation

Manual Calibration

Calibration is best done with a frequency generator to simulate the engine speed input
and a frequency meter. A zero-crossing input of 2 Vac minimum is required. Setup
consists of the following:

1. Set glow plug potentiometer to maximum time (fully clockwise — potentiometer
will click at end of travel).

2. Apply power to controller. All three LEDs should turn on for one second,
indicating normal operation.
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3. Turn on frequency generator and set to the crank disconnect frequency. The
green status LED should turn on continuously, indicating a good speed signal
from the generator.

4. Apply power to the VER switch input to initiate the starting sequence. The
Glow Plug controller will turn on first for the pre-heat duration.

5. When the red LED for the autocrank channel turns on, the pre-heat time is
over. Use the glow plug channel potentiometer to adjust the pre-heat time.

6. Install DSS-2 on engine and confirm glow plug and autocrank operation.
Adjust pre-heat time as required.

The range of pre-heat times commanded is adjustable using the ACT. The range
can be varied with the potentiometer between zero and GLOW PLUG_TIME.

Glow Plug Controller Adjustment Using ACT

ACT can be used to customize the range of glow plug pre-heat times in the DSS-2.
Refer to Chapter 5 for general information regarding installation, connection and
operation of ACT. The Calibration Wizard is the preferred approach to ACT
calibration, but similar results can be obtained using the Calibrate/Change DSS-2
Calibration Menu item.

To launch the Calibration Wizard:

Select “Calibrate”, then Calibration Wizard.
2. Select default values or current values as a starting point in the calibration.

3. Enter the number of teeth on the flywheel. If you wish to work in Hz, enter a
value of 60. If you wish to work in rpm, enter the correct number of flywheel
teeth.

4. The following information applies to both Channel 1 and Channel 2.

Enabling Glow Plug Control
DSS-2 Calibration Wizard X

Chanrel Configuration Channel 1

Channel Configuration: | e
In the first Wizard Reverse Spes Swieh Mo
window, left click on i o Conler
the down arrow in the
selection box and
select Glow Plug
Controller. Click on
Next to move on to

the next selection.

< Back I Mest > Cancel
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Pre-Heat Time

DS5-2 Calibration Wizard X Range of Adjustable
Pre-heat Time:
Channel Corfiguration Channel: | 1 This parameter adjusts
Chanml Corfiuraion [Tl Pt o] the maximum value for
Glow Plug preheat time [sec] 100 Glow P|Ug pre-heat time.

The multi-turn
potentiometer for the
channel assigned to glow
plug control can be used
to adjust the pre-heat
time between zero and
this paramer.

Cancel

Engine Protection Switch Configuration

ACT can be used to configure the Engine Protection (EP) input to the DSS-2. Refer
to Chapter 5 for general information regarding installation, connection and operation
of ACT. The Calibration Wizard is the preferred approach to ACT calibration, but
similar results can be obtained using the Calibrate/Change DSS-2 Calibration Menu
item.

To launch the Calibration Wizard:

1. Select “Calibrate”, then Calibration Wizard.
2. Select default values or current values as a starting point in the calibration.

3. Enter the number of teeth on the flywheel. If you wish to work in Hz, enter a
value of 60. If you wish to work in rpm, enter the correct number of flywheel
teeth.

4. Follow the steps covered in previous sections to configure the two speed
switch channels.

DSS-2 Calibration Wizard 3] To ignore EP input
before starting: Some
S engine protection inputs,
Sy o such as oil pressure
it cs] [ switches, indicate a
Debounce Timsmsecl [0 failure when the engine is
Loss cf Speed Signal e seck [0 not running. To prevent

latching of unintended
faults, set Enable RPM to
a non-zero value that
indicates normal engine
operation.

< Back Mest > Cancel
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To ignore EP input for a brief period after starting: Set Run Time (sec) to a non-
zero value.

To ignore intermittent switch contact closures: To provide some basic switch
contact debounce, set Debounce Time (msec) to a non-zero value.

To detect an absent speed input: If a channel is configured as a speed switch
which latches a fault on loss of speed signal, it is possible to detect a missing speed
signal without having first seen a valid speed signal. Set Loss of Speed Signal time
(sec) to a non-zero value. Once battery power is applied to the VER switch input
(Start Switch), the Loss of Speed Signal logic expects to see a speed signal with this
amount of time.

Completing Wizard Configuration

RS5:2 Calboatian Yizend 5l After configuring the Engine
Protection input, the Wizard
Review your selections and click Next to calibrate the controller.
eigion [ Saaion | presents a summary page. The
Number of fywhes teeth 60 . .
emitomiae  lomgn user should confirm all settings
Ch: 11 Min Set Speed 2600.0
Channat M:‘xﬁgelﬁlf:ed 5000.0 ;E: and use the “<BaCk” button to
Channel 1 Set Delay a ms
Chanriel 1 Reset Del 26214 1 1
e e o correct any discrepancies.
Channel 2 Configuration MNormal Speed Switch
Channel 2 Reset Type Automatic Reset on % of 5.
Channel 2 Min Set Speed 25000 pm
Ch: | 2 Max Set Speed 5000.0 H H H
Charei 26500y D After reviewing the summary, click
Charnel 2 Reset Delay 26214 s « »
i on “Next>" to download the values
Protection:Fun Ti oo
PrtactionDebaunce Tine 50 to the DSS-2.
Protection Loss Of $peed Time a0 sec
< Back Next > Cancel
DSS-2 Calibration Wizard 3]

The D33-2 Calibration Wizard is complete!
Far futher calbration, you may s the Calbrste/Change DSS-2 Calibration aption.
o display variables such as engine speed in real ime you may use the

MonitorParameter View option. Please refer to the Lser's Manual for a complete
discussion of features and calibration procedures.

The final screen presents a
signoff message. Select “Finish”
to complete the calibration
process.

Click Firish to retum to the main menu.
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Chapter 5.
ACT Operation

ACT Installation
ACT Kit Contents

The All-purpose Calibration Tool (ACT) is used for programming (configuring and
adjusting) and monitoring the DSS-2 controller with your personal computer. The
ACT kit contains the following:

e Software CD-ROM

e RS-232 connecting cable
e CD-ROM Installation Guide

Set-up Requirements
Hardware Requirements

e IBM compatible personal computer equipped with a CD-ROM drive and a
serial port with DB-9 connector, capable of 9600 baud communication

e Windows software: 95/98/Me/2000/XP

e 64 MB of available RAM memory and a hard disk with at least 2.0 megabyte
of free disk space

e SVGA capable video card and monitor, capable of 256 colors and 800 x 600
display

Software Requirements

CD-ROM of calibration tool software to run on your personal computer.
(CD supplied with ACT Kkit.)

Hardware Set-up

To connect your PC to the DSS-2 use the cable provided with the calibration tool kit.
This cable has a DB-9 connector on one end and a four-pin white plastic Molex
connector on the other end.

Connect one end of the RS-232 cable to your PC’s COM port. Connect the other
end of the cable to the control module.

NOTE
@ The DSS-2 must be powered up in order for ACT to operate.

CAUTION

@ The serial/COM port and ACT software are intended only for configuration
and periodic service. Do not leave a computer and/or serial/COM cable
connected to the serial/COM port.
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Figure 8. ACT System Set-Up

Software Set-Up

ACT software can be automatically installed on your hard drive from the CD-ROM
supplied with the kit. To install the software, follow the procedures below.

NOTE
@ Close all applications to prevent possible conflict between the ACT
installer and other programs.

1. Turn on your computer and insert the ACT disk into the CD-ROM drive. The
install program should automatically launch. If it does not, open Windows
Explorer, go to the CD-ROM drive and double click on the install program.

2. Follow the prompts from the install program. You may select the default
directory or specify your own.

3. When installation is complete, you may access the ACT software from the
Start Menu or create your own shortcut.

4. The set-up is now complete and you are ready to run ACT.

e Torun the ACT software, please refer to “Running the ACT
Software” in the following section.

e Put the original CD-ROM in a safe place in case the files on your
hard drive become damaged or lost.
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Basic ACT Operation

Running the ACT Software

The ACT software is fairly easy to use. Follow the procedures below to run the program.

1. Make certain that the DSS-2
controller is powered up and
connected to the computer’s
COM port.

2. If anicon for the calibration
tool exists, double click on it to
start the ACT software. The
license screen will be
displayed when the ACT is
launched. You must either
accept the terms or Cancel,
which exits the application.

License Agreement

I

Coppight C) 2004 woodward, Inc.

Thiz soétware and the accomparying witten matenals sre copsrighted.
Thiz softvsare may not be coped. in whole or m pait.

regardless of the form of media, without prior

wiilten coneni of WWoodward, Inc

Yfoodeard, Inc. makes no waranties. express

of impiied, with respect 1o the soflware, of itz quality.
performance, merchantabdity. or ftness for any parliculss
purpoze. The zoftware i beensed and delfvered “asis”

Any damages. lnsz of propery, or other costs resulling
from the wse of thiz soitwaie is the sole respansibiity
of the indiidual or organization uzia it

1L. e e e s e

3. If noicon exists, click on the Start button, highlight “Programs,” find the ACT
software and click to start it. Default is Woodward, then select “APECS-EPS

Calibration Tool.”

4. Make sure the COM port designation in ACT matches the serial port on the

back of your PC.

5. Follow the procedure outlined in the Configure Menu to change the COM

port assignment, if needed.

Progress Display Screen

This screen is intended to inform the user of the progress of time-consuming
communication procedures. It will close automatically when the procedure is

complete.

Froease Cali alon Yaksae

EE_F&ULTE_1
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Moving Around the Software

There are five main menu items available with ACT. Several options are available
under each main menu item. The discussion in the following pages assumes the
cursor is at the main menu screen.

e Use mouse to select or move around the menu.
e Use left mouse to execute a command or accept a condition.
e Use function key <F1> for HELP.

e A HOT key (highlighted character in a menu item) can also be used to
access or activate a menu or sub-menu, e.g. File use <ALT> <F>.

e Click on the [x] box in the upper right hand corner to exit ACT.

ACT Menus & Options

ACT Menu Structure

ACT’s five main menus—File Menu, Calibrate Menu, Monitor Menu, Configure
Menu, and Help Menu have several options available under each. A complete
discussion of all ACT menus and options is presented in the following pages.

Save DSS-2 Cal to File

View Cal File Comments

View Text File
Convert DSS-2 Cal to Text
Convert Cal File to Text

FILE MENU

Convert Cal File to Strategy

Change DSS-2 Calibration
Download Cal File to DSS-2
CALIBRATE MENU Compare DSS-2 Cal to File Cal
Change DSS-2 Password
DSS-2 Calibration Wizard

Parameter View

Parameter Plot

MONITOR MENU Display Faults
Control Strategy

Parameter List

CONFIGURE MENU Configure Serial Port
Help Topics
HELP MENU About ACT

User Manuals
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File Menu
Purpose

The File Menu allows you to perform operations related to viewing, saving and
converting files. The following commands are available under the File Menu.

e Save DSS-2 Cal to File

e View Cal File Comments

e View Text File

e Convert DSS-2 Cal to Text
e Convert Cal File to Text

e Convert Cal File to Strategy

Save DSS-2 Cal to File

This command allows you to save DSS-2 calibration data to a designated file. The
ACT uploads the calibration set from the DSS-2 controller and saves it to a
computer file. This operation is usually done after the controller has been calibrated
for satisfactory engine performance but can also be done at any other time. The data
is saved in a binary file format that is not readable.

To Save DSS-2 Cal to File:
1. Choose File > Save DSS-2 Cal to File.
ACT W|” prompt the path Where the flle Select/Create File Name to save to. E]@

will be saved: Saveire | ALT 7.3 - eF B

B ator_cos.acT
=) spo1130.80T

2. Enter afile name to save the
calibration data to.

ACT will automatically append the file
extension .ACT to the file name if you

do not specify one. Click Save or i R [see |
preSS <Enter>_ Save as lype: |CAL Files [*ACT] j Cancel
ACT will then read all of the current e o o

calibration values from the
controller. This screen shows the
progress.

FROPORTIONAL_GAIN

]

ALT X
Once all the values are read, ACT
ill prom dd commen \
\t,;:lg 5)\81— ﬁ |teytoou atIC()j ain lat g r ents to .\_::) Do you wish bo edit the new Cal File Comments?

identification.

30 Woodward



Manual 36598A DSS-2 Two-Channel Digital Speed Switch

Cal File Comment List 3

3. Ifyou click Yes, the
comment editor screen will
appear.

Cal File Name [C:Woodwaid\ACT 7_3My D ata AC
e

at T001pm
rotectionn at 200 iprm

To enter comments, type
them one at a time and
press <Enter> or click Save
Edit. You can re-edit
Comments by CliCking them, Debte | AddAsNew |  SaveEdt | CancelEdt |
changing the text on the top L e
line and clicking Save Edit. Comments can be deleted by clicking on them
and then clicking “Delete” or by pressing <Del>.

4. Click OK on the comment editor or press <Enter> twice to save comments. Click
Cancel or press <Esc> twice to close the window without saving comments. The
Cal File will still be created if the comment editor is canceled.

5. The following message is displayed when the file is created successfully.

L
\y Ciiwoodward\ACT 7_3\My Data, ACT Created Successfully

The file name in this message is the file selected in Step 2. ACT will save the
calibration data to the designated file and display “Calibration Data Saved in File:
ABCD.ACT” message (where ABCD is the name you entered in Step 2).

NOTE

@ The “Save DSS-2 Cal to File” command stores the calibration
data as an .ACT file that cannot be viewed or printed directly.
Viewing and printing must be done from a converted text file.
See “Convert DSS-2 Cal to Text” and “Convert Cal File to Text”
commands.

View Cal File Comments

Th|S com mand a”OWS you to Select a Calibration file and its comments are displayed ... E][g|
display the comments that are Look i [ A4CT7_3 = ef B3
attached to a calibration file. Users | Essicorom [Eloemosonooo  [Hpemonssz.oo0

add comments when savinga | I Zeviner Zec
calibration file. The comments [ apza1na05.000 [ pEMO4000.000

=] Apxa1p0s.000 DEMO4500,000 [ S001130.ACT

he|p.in t_raCking SpeCIfIC engine, B apxstsor.000  [E pemosoon.oon [ sss11m03.000
application, and environment data
for which the calibration file was

< >

File name: |My DataACT

created.
Files of lype: |Eal Files(* 000;* ACT) j Cloze
To View Calibration Comments: M Ll
Calibration File Carnmets:
1. Choose File > View Cal File 2 B ok Do 5700
Com m entsl i: Channel 2: Engine Overspeed Protectionn at 2000 rpm
i . i . 5. Engine Protection enabled
ACT will display a list of files CE—

on the left side of the screen
with file comments on the
right.

Woodward 31




DSS-2 Two-Channel Digital Speed Switch Manual 36598A

2. Use the Up and Down arrow keys to highlight the desired calibration file
(.ACT extension) and view the comments attached to that file.

3. Click OK or Cancel to close Comment Viewer. The comments are created
or edited when the files are created.

View Text File
This command is a convenient way to view text files.

1. Choose File > View Text File.

2. ACT will prompt for a text file to view.

3. Select a file and click OK.

4. ACT will open the selected file with the default viewer for that file type.

Convert Commands

The “Save DSS-2 Cal to File” command, discussed earlier, stores the calibration
data as an .ACT file that cannot be viewed or printed directly. Viewing and
printing must be done from a converted text file.

There are two convert commands available with ACT: “Convert DSS-2 Cal to
Text” and “Convert Cal File to Text.” The difference between the two commands
is as follows:

1. In “Convert DSS-2 Cal to Text” operation, the calibration set that is
converted is from the DSS-2 unit.

2. In*“Convert Cal File to Text” operation, the calibration set that is converted is
from a previously saved file.

You may use the View Text File command to view text files.

Convert DSS-2 Cal to Text

This command allows you to create a text file of DSS-2 calibration data for viewing
or printing from any text editor utility in Windows. A printed copy of the calibration
data can be useful for future reference.

To Convert DSS-2 Calibration to Text:
1. Choose File & Convert DSS-2 Cal to Text.

2. ACT will prompt you to enter a name to save the text file. Enter a file and
click OK.

ACT will read all of the calibration values from the controller, create and
save a text file with the parameter names, values, and units, then display
the file using the default text viewer.
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Convert Cal File to Text

This command allows you to convert a previously saved .ACT calibration file to a
text file for viewing or printing from any text editor utility in Windows. A printed copy
of the calibration data can be useful for future reference.

To Convert Cal File to Text:

1. Choose File = Convert Cal File to Text.

2. ACT will prompt you to enter a name to save the text file. Enter a file and click
OK.

ACT will read all of the calibration values from the controller, create and save
a text file with the parameter names, values, and units, then display the file
using the default text viewer.

Convert Cal File to Strategy

This command is used to convert old ACT files for use with controllers that have a
different control strategy version.

ACT will:
1. Parse through all of the calibration parameters in the old ACT file.

2. Search for the same calibration parameters in the new ACT file and
assign values from the old calibration.

To Convert a Cal File to a New Strategy:

1. Choose File > Convert Cal File to Strategy.

2. ACT will prompt you to enter a name to save the text file. Enter a file and
click OK.

ACT will read all of the calibration values from the controller create and save
a text file with the parameter names, values, and units, then display the file
using the default text viewer.

Calibrate Menu

The Calibrate Menu allows you to perform operations related to DSS-2 calibration.
The following commands are available:

e Change DSS-2 Calibration*

¢ Download Cal File to DSS-2*

e Compare DSS-2 Cal to File Cal
e (Change DSS-2 Password*

e DSS-2 Calibration Wizard*

(*) These commands can be password protected to prevent unauthorized
calibration changes. See “Change DSS-2 Password” for more information.

Change DSS-2 Calibration

The “Change DSS-2 Calibration” command allows you to calibrate (configure and
adjust) various parameters associated with the DSS-2 controller.
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DSS-2 is a programmable speed switch. Changing DSS-2 calibration parameters is
a means to configure the DSS-2 controller for specific engines, applications and
environments.

The calibration parameters have been organized into categories for your
convenience. Browse through the categories to view the specific parameter you
want to change or adjust.

Some parameters must be set before the engine can run. Other parameters can be
adjusted while the engine is running. A complete list of parameters appears in the
following pages.

All adjustments are stored immediately in non-volatile memory in the DSS-2 unit.
The DSS-2 controller will retain the changes even if power is lost or the ACT is
disconnected.
To Change DSS-2 Calibration Parameters:

1. Choose Calibrate > Change DSS-2 Calibration.

Set the “View Filter” to select a group of parameters.

Use the mouse to scroll through the list.

P @b

To change the highlighted parameter:
Enter the new value in the “New Value” field.
Press <Enter>.

The new value is written to the controller and then read back,
with the result placed in the “DSS-2 Value” field.

5. Press <Esc> to exit.
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Calibration Categories

To incorporate any of the programmable features in your system, a set of
parameters associated with each feature must be calibrated using the calibration

tool (ACT). These parameters are grouped under various categories under the

Calibrate Menu in ACT. (Refer to Table 1 below.)

Table 1. Calibration Categories and Features

CALIBRATION CATEGORY

FEATURES AVAILABLE

Channel 1 Calibration

Operating Mode (Normal / Reverse /
Autocrank / Glow Plug)

Reset Mode (Auto / Switch / Latch)
Speed Range
Set/Reset Delays

Channel 2 Calibration

Operating Mode (Normal / Reverse /
Autocrank / Glow Plug)

Reset Mode (Auto / Switch / Latch)
Speed Range
Set / Reset Delays

Speed Input Calibration

Number of pulses on flywheel

Engine Protection Switch

Enable rpm / delay

Autocrank/Glow Plug
Calibration

Crank Time
Rest Time

Maximum Crank Attempts

All Parameters

Contains list of all calibration
parameters

Woodward
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List of Parameters

The parameter list provides information regarding each of the parameters that can be
adjusted when a computer is connected to the controller via the COM port and the ACT
software. The COM port and ACT are intended only for configuration and periodic service.
Do not leave a computer and/or COM cable connected to the COM port.

CATEGORY

PARAMETER

DESCRIPTION

FACTORY
CAL

Channel 1
Calibration

CHNL_1_CONFIG

Configuration bits, Channel 1.
Bit 7: 1= Overspeed Fault Enable

Bit 5: 1 = Sequence bit— Ch 1 after
Ch1

Bit 4: 1 = Go to set on Loss of
Speed Signal

Bit 3: 1 = Go to set on Verify Sw =
Off

Bit 0: 1 = Go to set on EP switch
active

000000001B

CHNL_1_OP_MODE

0 = speed switch, standard relay
logic

1 = speed switch, reverse relay
logic

2 = autocrank, using Verify Sw

3 = glow plug mode, using Verify
Sw.

CHNL_1_RESET

0,1 = auto reset at
RESET _PCNT _1 of Channel 1 set
speed

2 = reset with external RST switch
3 = latched reset

RESET DELAY_1

When in auto reset, time below
reset speed before reset occurs

0 msec

RESET_PCNT_1

When in auto reset, percentage of
set speed at which reset will occur

80%

SET_DELAY_1

Time above set speed before set
will occur

0 msec

SET_SPEED_1_MIN

Minimum set speed/frequency from
Channel 1 potentiometer

2500 Hz

SET SPEED_1_MAX

Maximum set speed/frequency from
Channel 1 potentiometer

5000 Hz
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Parameter List (Cont'd.)

CATEGORY

PARAMETER

DESCRIPTION

FACTORY
CAL

Channel 2
Calibration

CHNL_2_CONFIG

Configuration bits, Channel 2.

Bit 7: 1= Overspeed Fault
Enable

Bit 5: 1 = Sequence bit — Ch 1
after Ch 1

Bit 4: 1 = Go to set on Loss of
Speed Signal

Bit 3: 1 = Go to set on Verify Sw
= Off

Bit 0: 1 = Go to set on EP switch
active

000000001B

CHNL_2_OP_MODE

0 = speed switch, standard relay
logic

1 = speed switch, reverse relay
logic

2 = autocrank, using Verify Sw

3 = glow plug mode, using Verify
Sw

CHNL_2_RESET

0,1 = auto reset at
RESET_PCNT_1 of Channel 1
set speed

2 = reset with external RST
switch

3 = latched reset

RESET DELAY 2

When in auto reset, time below
reset speed before reset occurs

0 msec

RESET_PCNT_2

When in auto reset, percentage
of set speed at which reset will

80%

SET_DELAY_2

Time above set speed before set
will occur

0 msec

SET_SPEED_2_MIN

Minimum set speed/frequency
from Channel 2 potentiometer

2500 Hz

SET_SPEED_2_MAX

Maximum set speed/frequency
from Channel 2 potentiometer

5000 Hz

Speed
Input
Configuration

PULSES_PER_REV

No. of pulses per engine
revolution
(if set to 60, rpm = Hz)

60

PULSES_PER_UPDATE

No. of pulses until next engine
speed update

Woodward
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Parameter List (Cont’d.)

CATEGORY PARAMETER DESCRIPTION FACTORY
EP_ENABLE_RPM Mlnlmum rpm to enable engine 0
protection switch
Minimum time above
EP_RUN_TIME EP_ENABLE_RPM to enable 0 sec
engine protection switch
Minimum engine protection switch
Engine EP_TIME closure time 50 msec
Protection
Switches Minimum time without speed signal
on startup to go to set condition if
LOSS_TIME Loss of Speed Signal set mode is 5 sec
enabled (CHNL_X_COFIG.4 = 1)
Percentage of normal set speed to
TEST_VERIFY_K go to set condition when Verify 0.7
Switch is activated
AUTOCRANK_CONFIG 1= Dis'able autocrank if engine 0
protection fault exists
AUTOCRANK_CRANK_ Maximum engine cranking time 10 sec
TIME before resting
AUTOCRANK_MAX Maximum number of crank 1
TRIES attempts
Time between onset of cranking
AUTOCRANK_NS_TIME | and a fault if no engine speed is 1 sec
Autocrank / observed
Glow Plug - ")\ 1ocRANK_REST
Calibration TIME — - Rest time between crank attempts 15 sec
Engine rpm above which
CRANK_DISABLE autocrank will be terminated and 700 rpm
normal engine rpm assumed
Maximum glow plug preheat time
before enabling crank. The actual
GLOW PLUG_TIME glow plug preheat time can be 10 sec
adjusted downward with the
potentiometer.
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Download Cal File to DSS-2

The “Download Cal File to DSS-2” command allows you to download the entire
calibration set from a file to the DSS-2 permanent memory. This is a convenient
one-step method for:

e Reverting back to a known good calibration set after
experimenting with new calibration settings

e Programming multiple DSS-2 units for a particular application

The downloaded file may have been previously configured and calibrated for
satisfactory engine performance with another DSS-2 unit.

To Download a Cal File to DSS-2:

1. Choose Calibrate > Chapse a Calibration file to, downlbad FIX
Download Cal File to @17 o« B
DSS-2. The following i Hoomomaoe Mo
screen allows you to = o= feeompodd= =
select a Cal file to = araipos.o00 =) DEMO4S00,000

|arvsis01.000  [Z)oEmosona.ono (=) sss11M03.000

download.

=

Ev

File name: My DataACT

Files of tupe: ‘Ea\ Files(*.000:* ACT) ﬂ Cancel

I Open as fead-only

Calibration File Comments:

1: DSS-2 Calibration for V-8 engine
2: Channel 1: Crank Disconmect at 700 rpm
3 Charnel 2: Engine Dverspeed Pratectionn at 2000 rpm

5 Engine Protection enabled

7. Greg Pence 7/15/05

2. Choose a file and click OK. The following screen will show the progress.

Processing Calibration Yalues

OYERSPEED_RPM

7

3. The following screen is shown when the operation is complete.

ALCT x|

) E The calibration file was downloaded successfully,
L

NOTE: During the “Download Cal File to DSS-2” operation, the user may
encounter a situation where the Cal File password is different from that of the
DSS-2 unit. If this happens, please refer to the steps below to complete the
download operation
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To Download a Cal File to DSS-2 with a Password Different from that of the
DSS-2 Unit:

Whenever the DSS-2 password is added or changed, the new password is stored in
the unit as well as in any calibration file saved after the change.

During a “Download Cal File to DSS-2” operation, if the password stored in the
calibration file matches the password in the unit, ACT will readily download the
calibration to the DSS-2 unit.

However, if the password stored in the calibration file does not match the password
in the DSS-2 unit, ACT will alert you of a password mismatch. Please follow the
steps below to complete the download operation.

1. When a password mismatch is detected, the ACT displays a message “Cal
File password differs from that of the DSS-2 unit. Download the Cal File
password to the DSS-2 unit?”

2. If you answer Yes to this message (see note below), the calibration file will
be downloaded and the password in the DSS-2 unit will be changed to
match the password stored in the calibration file.

3. If you answer No to this message, the calibration file will still be downloaded
but the password in the unit will remain unchanged.

NOTE

@ Before answering Yes to the message, make sure you know the
password in the calibration file. If you do not know the password,
you will not be able to access the password protected features
under the Calibrate menu

Please see “Change DSS-2 Password” command for more information on password
protection.

Compare DSS-2 Cal to File Cal
This command lets you check the differences in calibration sets between a saved

file and the DSS-2 unit. The feature is useful, for example, to ensure that the saved
file matches the calibration in the DSS-2 unit.

TO Compare DSS'2 Cal tO File Cal . Choose a Calibration file to compare @@
) Look in: |_)AET 3 j oF B
1. Choose File - Compare DSS-2 Cal to ey ey e ] Py

=) spx01mot.000 [ apx41mo4.000 [ DEMOI000.000 [ Lss01mMo1 000

File Cal. This screen allows you to select [E apxa1c04.000 B sexa1rvos.000 [ cemosno.ooo [ TS
a Cal File to compare. [ apsatcos.oon =] apxatPos.000 [ DEMO4SD0.000 [ 3D0113D.ACT

[ spxa1c06.000 APX51501,000 DEMOS000.000 B 55511M03.000

< >
Flepame:  [My DataACT
Files of type: | Cal Files.000;%.ACT) Ea Cancel

I Open as rzad-only

Calibration File Comments:

1: D55-2 Calibration for ¥-8 engine

2: Channel 1: Crank Disconnect &t 700 mpm

3: Channel 2 Engine Overspeed Protectionn at 2000 mpm
1

5: Engine Pratection enabled

7: Greg Pence 7/15/05
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2. Choose a file and Click OK.
ThIS screen W|” ShOW the Processing Calibration Values
progress.

WERSPEED_RPM

1

3. Once all parameters have been processed,  [X#i} X
a message box will list the compare results.
If the parameters in the file match the & File Matches Controller
controller, the following message box
appears:

4. Click OK to close. If there were mismatches, the following message will
appear:

Compare Differences El
Controller <y C:“WOODWARDNACT 7_3%~LSS01M01.000 Mismatch List

Hame File Controller Units
CHHL 1 CONFIG 00010000 00000001 HOHE
CHNL 2 _CONFIG oooloooo 00000001 HONE
EE_FAULTS 1 oooooooo 00001000 WOWE

TR

Close ‘

You may select "Save to File" if you would like to save a permanent record
of the file compare. You will then be asked to select a destination directory
and file name.

Change DSS-2 Password

This command allows you to add or change a password to protect certain calibration
features. The option is useful, for example, to prevent unauthorized changes to a
known good calibration set in the DSS-2 unit.

By default, the DSS-2 unit is not password x|
protected.
To Change DSS-2 Password: Please enter the contraller password:l""ﬂ
1. Choose Calibrate > Change DSS-2
Password. You will be prompted for Charce | cancel [ 0K ]
the current password. I

IEnter pazzward and click OK.
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2. The application will x

query the controller to

verify that the entered

password matChes the e33e enter tne coniroller password:
current password. If the i 1 the centiolerp d'l
password matches, the

“Change” button is

enabled: e Change | Cancel | oK I

IPassword Walid. Click 'Change’ ta chahge contraller password

3. Click “Change” and the application will prompt for the new password:

Password Management il

Enter new Password: I

Change I Cancel | ak |
Status:

Password Change Mode.

4. Enter the new password. It should be one word, no spaces, and up to
11 characters long. Once entered, click OK. The application will prompt
to re-enter the password to make sure that it was typed in properly:

5. Re-enter the password and click x|

OK. If the two entries of the new

password are equal, the new

password will be encoded and Re-snter new password: || |
saved in the controller.

Passwords are upper and lower case Change |  Cancel | ok |

it Status:
nsitive.
sensitive IPassword Change Mode.

After changing your password, please record it in a safe place for future reference.
To revert to no password protection, change DSS-2 password to “peg,” which is the
default password.

ACT Operation with the New Password:

Once a password is added or changed, the following calibration features become
password protected:

Change DSS-2 Calibration
Download Cal File to DSS-2
Change DSS-2 Password
DSS-2 Calibration Wizard

At the start of any future sessions, ACT will always prompt you to enter the new
password to gain access to these features. You only need to enter the password
once during any session to gain access to all password protected features.
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DSS-2 Calibration Wizard

Y

The DSS-2 Calibration Wizard is an interactive guide to help you get your controller
unit up and running as quickly as possible.

To Calibrate a Controller Unit Using the DSS-2 Calibration Wizard:

1.

Choose Calibrate - Calibration Wizard (or select the tool button shown
above).

The Wizard will give you the option to use the default calibration or modify
the existing one. If you select the default calibration, the Wizard will reset all
calibration parameters.

Press <Enter> to continue or <Esc> to abort the Wizard.

If you press <Enter> the Wizard will lead you through the calibration
process with a series of questions. When all questions have been
answered the Wizard will ask you to confirm that the values entered
are accurate.

Press <Enter> to confirm the values, <PgUp> to go back and change the
values, or <Esc> to abort the Wizard.

If you press <Enter>, the DSS-2 Wizard will download the new calibration
and reset all DSS-2 parameters. This will complete the DSS-2 Wizard
operation.

NOTE
@ The DSS-2 Calibration Wizard only covers basic calibration. It does

not automatically assure optimum engine operation. Please refer to
DSS-2 Calibration Procedures for more information.

Woodward
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Monitor Menu

The Monitor Menu allows you to observe engine and DSS-2 operation in real time.
The following commands are available under the Monitor Menu.

e Parameter View
e Parameter Plot
e Display Faults

e Control Strategy
e Parameter List

Parameter View

This command allows you to view certain operating variables (i.e., engine speed) in
real time.

To View Parameter Values in Real Time:

1. Choose Monitor > Parameter : -
View. The application will

launch the view screen. e [ Value | Urits_|
engine_rpm 0.0 pm
zet_speed 1 23450 pm
i w2 e
2. The screen automatically T | | o o
Starts readlng Values from the switch_debounced 00000000 WOME
controller and displaying the
values.

3. To stop the updating, click on
Stop. The button name will
then change to ‘Start.” Clicking
it again will start updating again.

NOTE

@ As shipped from the factory, n_desired will actually be in units of
Hz, not rpm as indicated. When PULSES_PER_REV = 60, n_desired
will display in Hz. To display actual rpm, change PULSES_PER_REV
and PULSES_PER_UPDATE to equal the actual number of gear teeth
per engine revolution.

NOTE

@ If any other screen is opened that requires communication with the
controller while the screen is updating, the Parameter View screen
will be automatically stopped.
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Parameter Plot

The Parameter Plot command lets you view engine performance on screen in the
form of a real-time graph. This feature allows you to perturb the system and observe
the response to fine tune engine performance.

To View Parameter Plot in Real Time:

Select Monitor - Parameter Plot. The application will launch and start the parameter
plot view.

[ Parameter Plot p

The application will read the
previously saved configuration
and request the controller to
start sending the parameter
values. The controller sends the
data to the PC at a rate that
varies with the number of
parameters being monitored.
The application uses the
Windows timer functionality to
update the screen at the
specified rate. Note that if the
PC is very busy, the timer
accuracy)\//vill v;ry; therefore, : : e [l
the screen and generated data | == s
files should be considered as T

reference only.

The X-axis time scale (25 seconds in the example screen) may be shorter than
configured due to the resolution of the monitor. This value will be adjusted when the
graph is resized. This also applies to the print functionality for this screen. All of the
data will be recorded in a revolving buffer for use by the “Save to File” feature (see
below).

The axis scales, parameter names, update resolution and time scale on the
Parameter Plot may be changed as described in the Plot Setup screen.

To Change Plot Setup:

This allows you to choose engine RPM, desired engine speed, duty cycle or any
other parameter for viewing real-time plots on screen. Axis scales can also be

adjusted to fit the parameter and/or speed.

1. On the Parameter Plot screen, click on “Configure.” The application will
show the following screen with the current values.
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x
Plat 1 Plat 2
I j Iengine_speed ﬂ
A Max I1 800 Auis Max I1 300
Ais Min I1 500 Ais Min IMDD
%tz Time Scale (20 [sec) Mumber Vertical Divisions |11 -
# Awiz Sample Bate |250 [m-zec) Mumber Harizontal Divisions I‘I‘I vl
Open | Save | Cancel I 0k I

Plot 1/ Plot 2

Use the pull-down to select the desired parameter to plot.

Axis Min / Max

Enter the minimum / maximum value for the parameter value.

X Axis Time Scale

Controls how much data is displayed on the X axis. This value may
automatically adjust for screen resolution.

X Axis Sample Rate

Controls how often the data from the controller is used to update the
screen. Data received between timer ticks is discarded.

2. Clicking OK will save this information in the Windows Registry so
that it will be remembered the next time the program is started.

NOTE

®

are no saved defaults.

The Calibration Wizard will automatically set up the plots if there

Display Faults

This command allows you to display present faults in real-time. This means if new
faults occur while you are monitoring, the screen will automatically update to display
the current faults. The display will also show historical fault codes that have been

previously logged but do not currently exist.
tracking down intermittent faults.

To Display Faults in Real Time:

1. Choose Monitor - Display
Faults from the main menu. The
application will launch the Fault
view.

The application will update the
display every time the controller
sends the fault_flags status. This
happens several times a second.

Click on the “Pause” button to
stop the automatic update of this

Historical fault codes are helpful when

M Diagnostic View =1L

Currert Faults:
Pause Source

fault_flags1
Clear Cunent Faults

| Error Description [
1) Channel 1 Overspeed Condition
12] Channel 2 Overspeed Condiion

faul_flags1

Histarical Faults,

Update Historical Faults | | Source

tfault_tlags1
fault_tlags1
fault_tlags1

| Historical Ermor Description
1) Channel 1 Overspeed Candition
2] Channel 2 Overspeed Candiion
[4) Engine Protection Switch fault

Clear Historical Faults
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screen. The text on the button will change to “Start” and clicking it again will
re-start the automatic updating.

®

NOTE

If any other screen requests data from the controller while this
screen is updating, this screen will automatically pause.

Control Strategy

This command allows you to check the version of the control strategy in use. This
information may be needed for strategy identification purposes and for future
updates.

The Parameter List screen allows the user to adjust which parameters are displayed
on the Parameter View display.

To Display the Parameter List:

1.

2.

Save
Clicking Save will prompt the user for a file name to save the currently viewed
configuration to.

Choose Monitor > Parameter List from the main menu.

The F5/F6 keys will backup/advance through the list. Press F9 or click on

“On View List” to
toggle the
selected
parameter on the
Parameter View
screen.

Click on the [ box
in the title bar or
press <Esc> to
close the screen.
Edits are not

Cal File Mame

[FEIPREVIOUS  [FEINEXT  [FS]ADD/REMOVE ONMIEW  [ESCICANCELEDIT / CLOSE

Parameter List [E[E1ES)

LSS01M01.000

“Wigw List Information
[~ On¥View List

View Postion

Open Save

saved between
application launches.

If the Parameter View screen is already open when changes are
made to the view list, close the Parameter View screen and re-open it
to make the changes effective.

Choose or, create a file to save the view setup to.

Savejn: [ ACT 7.3

|

EIX]

B cf E-

Type in a file name that reflects the purpose
of the saved configuration and click Save. The
view configuration dialog will now display the
selected file name in the title bar.

Open

Clicking Open will prompt the user for a file
name of a previously saved View
Configuration.

Select the desired file and click Open. The
View Configuration will be updated with the

File name: |My Display Datd

Save

Save as ype: [ACT View Setup Files [avi]

j Caricel

saved parameters.
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The ACT application will always recall the default set of plot configuration parameters
at application startup, and does not recall the last used view setup file. So the view
configuration will always start with the default view.

Several parameter view screens can be open with different configurations by changing
the configuration on the parameter list screen (F9 or Open), then opening a new
Parameter View.

NOTE
@ Only one of the parameter view screens can be monitoring the controller
at once.

Configure Menu

Configure Serial Port

This command allows you to designate the proper COM port for your PC to enable
communication between the ACT and the DSS-2 controller.

To Configure the Serial Port:
1. From the main menu screen,

choose Configure - Custom
Serial Port. The application will

ACT Communications Configuration

Serial Controller Connection Demo Mode

display the following screen: ¢ Com £ EPS 1000 Cancel
. " Com2 " APECS 500
2. Choose a port and click OK. Cowon [ || € aPECS 300

This screen will be displayed on
application startup if a controller
cannot be found at the last
selected port and can be
changed any time after the
application has started.

" APECS 4000
" APECS 4500
™ APECS 5000
{¢ DS5-2

Demo Mode
This mode will use a calibration file “Demo.000” and use random numbers for
values requested from the controller.

COM1/COM 2

This mode will look for a controller attached to the selected serial port. An
error message will be displayed AFTER you click OK if a controller cannot be
found or if the port cannot be opened.

COM ports outside of this range can be used by editing the default COM port
registry key for this application.
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Help Menu

The Help Menu provides access to the online user's manual and other information helpful
to your use of the calibration tool. The following commands are available under the Help

Menu:
e Help Topics
e About ACT

e User Manuals

Help Topics

This command allows you to search for specific information by displaying software menu
items or through key words.

1. Click on “Contents” for an outline of the software applications listed by menu
items.

2. Click on “Index” or “Find” to locate a specific topic through an alphabetical
listing or by typing in a word or phrase.

3. Follow the on-screen commands to page through the manual.

About ACT

This command displays the version of the calibration tool that you are currently using. This
information is important for tool identification purposes and for servicing support.

User Manuals

This command accesses the User Manual, which includes comprehensive information on
the DSS-2 controller, wiring diagrams, ACT software menus, and calibration parameters.
The manual may be viewed online or printed for future reference.
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Chapter 6.

Troubleshooting
|

General Checklist

Please follow the checklist below to troubleshoot your DSS-2 controller.

We recommend using a digital multimeter capable of measuring frequency and duty
cycle such as a Fluke 83 or Fluke 87.

1.

Check battery voltage for stability and correct value. The LED will turn on for
one second when the DSS-2 is first powered up.

Confirm that magnetic pickup output voltage is at least 2 Vs using the AC
volt settings on voltmeter. The LED will illuminate when it senses an engine
speed.

Confirm that the channel LEDs transition at the appropriate frequencies.

With the loads disconnected from DSS-2, use an onmmeter to confirm that
relays are working as expected. With no power to the relay, there should be
continuity between the C and NC contacts and no continuity between C and
NO contacts. With the relay engergized, there should be continuity between
the C and NO contacts and no continuity between C and NC contacts.
Relays can be damaged due to excessive currents. Always remember to
attach a suppression diode across large inductive loads.

Confirm that all external loads are functioning properly and continuity exists
in the wiring harness.

Fault Codes

The DSS-2 controller is capable of identifying certain fault conditions and
alerting the user to them. A flashing green LED indicates the fault conditions.
The current fault code list is shown in Table 2. Please note the following:

1.

When power is first applied to the controller, the green LED will flash just
once for one second to indicate that the LED is working.

If there are multiple faults, the LED will flash them all in sequence. Count
the flash codes to determine the fault conditions or connect the calibration
tool to observe the fault conditions. (Use the “Display Faults” option under
the Monitor Menu.)

If there are no faults, the LED will flash once at reset and from then on
indicate the detection of engine speed. A continuous ON LED indicates that
a valid engine speed is being sensed.

The controller will attempt to shut down for some faults and will not permit
starting after reset with faults 4 and 16.
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Table 2. Fault Codes

'::Lc';\sg FAULT RESPONSE CAUSE
Engine rpm has exceeded Channel 1
1 gc:rr;nile:j Set Condition | speed setpoint and
P CHNL_1_CONFIG.7 = 1.
Engine rpm has exceeded Channel 2
2 Channel 2 Set Condition | speed setpoint and
Overspeed CHNL_2CONFIG.7 = 1.
4 Engine Protection | Set Condition | Engine Protection switch activated.
Disappearance of speed signal. . .
No speed signal within
LOSS_TIME of power up
7 Loss of Speed Set Condition OR
Signal
No speed signal within
AUTOCRANK_NS_TIME of
autocrank.
There have been AUTOCRANK_MAX_
8 Overcrank No autocrank | TRIES attempts to start engine, and
engine has not started.
Parameter PULSES PER_REV must
have a non-zero value. Enter the
9 DS.S'Z No operation nL_meer of tegth per engine rev if you
Uncalibrated wish to work in units of rpm, or enter a
value of 60 if you wish to work in units
of Hz.
Defaults to
10 Channel 1 Set Pot | minimum Consult factory.
out-of-range speed
Defaults to
11 Channel 2 Set Pot | minimum Consult factory.
out-of-range speed
16 Controller unit Yes Consult factory.
failed
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Glossary of Technical Terms

ACT (All-purpose Calibration Tool) Software
PC software program for configuring and calibrating the DSS-2 controller

Actuator
Device that converts an electrical signal from the DSS-2 controller to an output shaft
position

Cal File
File containing DSS-2 calibration data

Cal Tool Version
The version of calibration tool software in use

Calibration
Process of configuring and adjusting the controller to work with a specific application

Calibration Wizard
Interactive software guide to help you set up basic calibration and get the controller
in operation quickly

Control Strategy
The version of software residing in the controller

DSS-2 (Digital Speed Switch, 2-Channel)
Two-channel speed switch developed by Woodward with both manual and computer
adjustable settings

Parameter
Numerical value that helps the user calibrate the DSS-2 controller

Speed Sensor
Device such as a magnetic pickup that senses engine speed
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Chapter 7.

Service Options
|

Product Service Options

The following factory options are available for servicing Woodward equipment,
based on the standard Woodward Product and Service Warranty (5-01-1205) that is
in effect at the time the product is purchased from Woodward or the service is
performed:

e  Replacement/Exchange (24-hour service)

e  Flat Rate Repair

e  Flat Rate Remanufacture

If you are experiencing problems with installation or unsatisfactory performance of

an installed system, the following options are available:

e  Consult the troubleshooting guide in the manual.

e  Contact Woodward technical assistance (see “How to Contact Woodward” later
in this chapter) and discuss your problem. In most cases, your problem can be
resolved over the phone. If not, you can select which course of action you wish
to pursue based on the available services listed in this section.

Replacement/Exchange

Replacement/Exchange is a premium program designed for the user who is in need
of immediate service. It allows you to request and receive a like-new replacement
unit in minimum time (usually within 24 hours of the request), providing a suitable
unit is available at the time of the request, thereby minimizing costly downtime. This
is also a flat rate structured program and includes the full standard Woodward
product warranty (Woodward Product and Service Warranty 5-01-1205).

This option allows you to call in the event of an unexpected outage, or in advance of
a scheduled outage, to request a replacement control unit. If the unit is available at
the time of the call, it can usually be shipped out within 24 hours. You replace your
field control unit with the like-new replacement and return the field unit to the
Woodward facility as explained below (see “Returning Equipment for Repair” later in
this chapter).

Charges for the Replacement/Exchange service are based on a flat rate plus
shipping expenses. You are invoiced the flat rate replacement/exchange charge
plus a core charge at the time the replacement unit is shipped. If the core (field unit)
is returned to Woodward within 60 days, Woodward will issue a credit for the core
charge. [The core charge is the average difference between the flat rate
replacement/exchange charge and the current list price of a new unit.]

Return Shipment Authorization Label. To ensure prompt receipt of the core, and
avoid additional charges, the package must be properly marked. A return
authorization label is included with every Replacement/Exchange unit that leaves
Woodward. The core should be repackaged and the return authorization label
affixed to the outside of the package. Without the authorization label, receipt of the
returned core could be delayed and cause additional charges to be applied.
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Flat Rate Repair

Flat Rate Repair is available for the majority of standard products in the field. This
program offers you repair service for your products with the advantage of knowing in
advance what the cost will be. All repair work carries the standard Woodward
service warranty (Woodward Product and Service Warranty

5-01-1205) on replaced parts and labor.

Flat Rate Remanufacture

Flat Rate Remanufacture is very similar to the Flat Rate Repair option with the
exception that the unit will be returned to you in “like-new” condition and carry with it
the full standard Woodward product warranty (Woodward Product and Service
Warranty 5-01-1205). This option is applicable to mechanical products only.

Returning Equipment for Repair

If a control (or any part of an electronic control) is to be returned to Woodward for
repair, please contact Woodward in advance to obtain a Return Authorization
Number. When shipping the item(s), attach a tag with the following information:

e name and location where the control is installed;

name and phone number of contact person;

complete Woodward part number(s) and serial number(s);

description of the problem;

instructions describing the desired type of repair.

é CAUTION
To prevent damage to electronic components caused by improper handling,
read and observe the precautions in Woodward manual 82715, Guide for
Handling and Protection of Electronic Controls, Printed Circuit Boards, and
Modules.

Packing a Control

Use the following materials when returning a complete control:

. protective caps on any connectors;

e antistatic protective bags on all electronic modules;

e  packing materials that will not damage the surface of the unit;

e atleast 100 mm (4 inches) of tightly packed, industry-approved packing
material;

a packing carton with double walls;

e astrong tape around the outside of the carton for increased strength.
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Return Authorization Number

When returning equipment to Woodward, please telephone and ask for the
Customer Service Department [1 (800) 523-2831 in North America or

+1 (970) 482-5811]. They will help expedite the processing of your order through our
distributors or local service facility. To expedite the repair process, contact
Woodward in advance to obtain a Return Authorization Number, and arrange for
issue of a purchase order for the item(s) to be repaired. No work can be started until

a purchase order is received.

NOTE
@ We highly recommend that you make arrangement in advance for return
shipments. Contact a Woodward customer service representative at
1 (800) 523-2831 in North America or +1 (970) 482-5811 for instructions and
for a Return Authorization Number.

Replacement Parts

When ordering replacement parts for controls, include the following information:
e the part number(s) (XXXX-XXXX) that is on the enclosure nameplate;
e the unit serial number, which is also on the nameplate.

How to Contact Woodward

In North America use the following address when shipping or corresponding:
Woodward Governor Company
PO Box 1519
1000 East Drake Rd
Fort Collins CO 80522-1519, USA

Telephone—+1 (970) 482-5811 (24 hours a day)
Toll-free Phone (in North America)—1 (800) 523-2831
Fax—+1 (970) 498-3058

For assistance outside North America, call one of the following international
Woodward facilities to obtain the address and phone number of the facility nearest
your location where you will be able to get information and service.

Facility = Phone Number
Brazil  +55 (19) 3708 4800
India  +91(129) 230 7111
Japan +81 (476) 93-4661
The Netherlands +31 (23) 5661111

You can also contact the Woodward Customer Service Department or consult our
worldwide directory on Woodward’s website (www.woodward.com) for the name of
your nearest Woodward distributor or service facility.
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Engineering Services

Woodward Industrial Controls Engineering Services offers the following after-sales
support for Woodward products. For these services, you can contact us by
telephone, by email, or through the Woodward website.

e  Technical Support
e Product Training
e  Field Service

Contact information:
Telephone—+1 (970) 482-5811
Toll-free Phone (in North America)—1 (800) 523-2831
Email—icinfo@woodward.com
Website—www.woodward.com

Technical Support is available through our many worldwide locations or our
authorized distributors, depending upon the product. This service can assist you with
technical questions or problem solving during normal business hours. Emergency
assistance is also available during non-business hours by phoning our toll-free
number and stating the urgency of your problem. For technical support, please
contact us via telephone, email us, or use our website and reference Customer
Services and then Technical Support.

Product Training is available at many of our worldwide locations (standard
classes). We also offer customized classes, which can be tailored to your needs and
can be held at one of our locations or at your site. This training, conducted by
experienced personnel, will assure that you will be able to maintain system reliability
and availability. For information concerning training, please contact us via telephone,
email us, or use our website and reference Customer Services and then Product
Training.

Field Service engineering on-site support is available, depending on the product
and location, from one of our many worldwide locations or from one of our
authorized distributors. The field engineers are experienced both on Woodward
products as well as on much of the non-Woodward equipment with which our
products interface. For field service engineering assistance, please contact us via
telephone, email us, or use our website and reference Customer Services and then
Technical Support.
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Technical Assistance

If you need to telephone for technical assistance, you will need to provide the following information.
Please write it down here before phoning:

General
Your Name
Site Location
Phone Number
Fax Number

Prime Mover Information
Engine/Turbine Model Number
Manufacturer

Number of Cylinders (if applicable)
Type of Fuel (gas, gaseous, steam, etc)
Rating
Application

Control/Governor Information
Please list all Woodward governors, actuators, and electronic controls in your system:

Woodward Part Number and Revision Letter

Control Description or Governor Type

Serial Number

Woodward Part Number and Revision Letter

Control Description or Governor Type

Serial Number

Woodward Part Number and Revision Letter

Control Description or Governor Type

Serial Number

If you have an electronic or programmable control, please have the adjustment setting positions or the
menu settings written down and with you at the time of the call.

Woodward 57



DSS-2 Two-Channel Digital Speed Switch Manual 36598A

Declaration of Conformity
|

DECLARATION OF CONFORMITY

Manufacturer’s Name:

Manufacturer’s Address:

Model Name(s)/Number(s):

Conformance to Directive(s):

Applicable Standards Tested:

Applicable Standards Evaluated:

WOODWARD GOVERNOR COMPANY (WGC)
Industrial Controls Group

1000 E. Drake Rd.
Fort Collins, CO, USA, 80525

DSS-2, Two-Channel Digital Speed Switch
(Component of a larger system)

89/336/EEC COUNCIL DIRECTIVE of 03 May 1989 on
the approximation of the laws of the Member States relating
to electromagnetic compatibility and all applicable
amendments.

ISO/EN14982 (1998): Agricultural and forestry machinery -
Electromagnetic compatibility

EN13309 (2000): Construction Machinery -
Electromagnetic Compatibility of Machines with Internal
Electrical Power Supply

EN61000-6-4, (2001): EMC Part 6-4: Generic Standards -

Emissions for Industrial Environments

EN61000-6-2, (2001): EMC Part 6-2: Generic Standards -
Immunity for Industrial Environments

EN12895, (2000): Industrial Trucks - Electromagnetic
Compatibility

We, the undersigned, hereby declare that the equipment specified above conforms to the above

Directive(s).

A

Signsture /

Douglas W. Salter

Full Name

Electronic Controls COE Engineering Manager

Position
WGC, Fort Collins, CO, USA
Place p
/ ~
7/03/65
Date

5-09-1183 Rev 10, 15-Jul-05

00350-04-EU-02-01.doc
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We appreciate your comments about the content of our publications.

Send comments to: icinfo@woodward.com

Please include the manual number from the front cover of this publication.

M, WOODWARD

PO Box 1519, Fort Collins CO 80522-1519, USA
1000 East Drake Road, Fort Collins CO 80525, USA
Phone +1 (970) 482-5811 ¢ Fax +1 (970) 498-3058

Email and Website—www.woodward.com

Woodward has company-owned plants, subsidiaries, and branches,
as well as authorized distributors and other authorized service and sales facilities throughout the world.

Complete address / phone / fax / email information for all locations is available on our website.
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